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Keyboard Tips - 

  

  

  

Keyboard Layout of Total Commander Shortcut 

Key Action 

F1 Help 

F2 Reread source window 

F3 List files 

F4 Edit files 

F5 Copy files 

F6 Rename files 

F7 Create directory 

F8 or DEL Delete files 

F9 Activate menu above source window (left or right) 

F10 Activate left menu or leave menu 

ALT+F1 Change left drive 

ALT+F2 Change right drive 

ALT+F3 Use external viewer 

ALT+F4 Exit 

ALT+F5 Pack selected files 

ALT+F6 
Unpack all files from archive under cursor (not 

working on Windows 95!) 

ALT+F7 Find 

ALT+F8 Opens the history list of the command line 

ALT+F9 
Same as ALT+F6 (because ALT+F6 is broken on 

Windows 95) 

ALT+SHIFT+F9 Test archives for integrity 

ALT+F10 Open a directory tree window 

ALT+left or right 
Open previous/next directory in list of already visited 

dirs 
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ALT+down Open list of already visited dirs 

SHIFT+F2 Compare file lists 

SHIFT+F3 
List only file under cursor, when multiple files 

selected 

SHIFT+F4 Create new text file and load into editor 

SHIFT+F5 Copy files (with rename) in the same directory 

CTRL+SHIFT+F5 Create shortcut of files in target directory 

SHIFT+F6 Rename files in the same directory 

SHIFT+F10 Show context menu 

SHIFT+ESC Iconize Wincmd 

NUM + Expand selection 

NUM - Shrink selection 

NUM * Invert selection 

NUM / Restore selection 

CTRL+NUM + Select all 

CTRL+NUM - Deselect all 

ALT+NUM + Select all files with the same extension 

BACKSPACE or 

CTRL+PgUp 
Change to parent directory (corresponds to cd ..) 

CTRL+PgDn 
Open directory/archive (also self extracting .EXE 

archives) 

CTRL+< Jump to the root directory 

CTRL+left or right 

Open directory/archive and display it in the target 

window. 

If the cursor is not on a directory name, the current 

directory is 

displayed instead. 

CTRL+F1 File display 'brief' (only file names) 

CTRL+F2 File display 'full' (all file details) 

CTRL+SHIFT+F2 Comments view 

CTRL+F3 Sort by name 

CTRL+F4 Sort by extension 

CTRL+F5 Sort by date/time 

CTRL+F6 Sort by size 

CTRL+F7 Unsorted 

CTRL+F8 Display directory tree 
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CTRL+F9 Print file under cursor using the associated program 

CTRL+F10 Show all files 

CTRL+F11 Show only programs 

CTRL+F12 Show user defined files 

TAB Switch between left and right file list 

Letter 
Redirected to command line, cursor jumps to 

command line 

INSERT Select file or directory 

SPACE 

Select file or directory (as INSERT). If SPACE is used 

on an unselected 

directory under the cursor, the contents in this 

directory are counted 

and the size is shown in the 'full' view instead of the 

string <DIR>. 

ENTER 

Change directory/run program/run associated 

program/execute command line 

if not empty. If the source directory shows the 

contents of an archive, 

further information on the packed file is given. 

SHIFT+ENTER 

1. Run command line/program under cursor with 

preceding command /c and 

leave open the program's window. Only works if 

NOCLOSE.PIF is in your 

Windows directory! 

2. With ZIP files: use alternative choice of these (as 

chosen in Packer 

config): (Treat archives like directories <-> call 

associated program, 

i.e. winzip or quinzip). 

ALT+SHIFT+ENTER 

The contents of all directories in the current 

directory are counted. 

The sizes of the directories are then shown in the 

'full' view instead 

of the string <DIR>. 

ALT+ENTER Show property sheet. 

CTRL+A Select all 

CTRL+B Directory branch: show contents of current dir and 
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all subdirs in one list 

CTRL+C Copy files to clipboard (32 bit) 

CTRL+D Open directory hotlist ('bookmarks') 

CTRL+F Connect to FTP server 

CTRL+SHIFT+F Disconnect from FTP server 

CTRL+N New FTP connection (enter URL or host address) 

CTRL+I Switch to target directory 

CTRL+L Calculate occupied space (of the selected files) 

CTRL+M Multi-Rename-Tool 

CTRL+SHIFT+M Change FTP transfer mode 

CTRL+P Copy current path to command line 

CTRL+Q Show Quick View panel instead of a file list 

CTRL+R Reread source directory 

CTRL+T Open new folder tab and activate it 

CTRL+SHIFT+T Open new folder tab, but do not activate it 

CTRL+U Exchange directories 

CTRL+V Paste from clipboard to current dir (32 bit) 

CTRL+W Close currently active tab 

CTRL+SHIFT+W Close all open tabs 

CTRL+X Cut files to clipboard (32 bit) 

CTRL+Z Edit comment 

CTRL+UP Open dir under cursor in new tab 

CTRL+SHIFT+UP Open dir under cursor in other window (new tab) 

CTRL+TAB Jump to next tab 

CTRL+SHIFT+TAB Jump to previous tab 

ALTGR+Letter(s) or 
Quick search for file name (starting with specified 

letters) in current 

CTRL+ALT+Letter(s) directory 

 
_____________________________________________________________
_ 

  

  

Command Line: Keys 
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If Total Commander is active, nearly all keyboard input is directed to the command line. 
Here the layout for some keys: 

ENTER 

The command line is executed, if it contains at least one character 
(otherwise, the program under the cursor in the source window is 
started). If the command is cd, md or rd, it is executed internally. If it 
is an internal DOS command, DOS will be executed with this 
command. Otherwise, a program with the given name is executed.  

SHIFT-ENTER 

Like ENTER, but with preceding command /c. After the called DOS 
program is terminated, its window is not automatically closed. This will 
only work if the file noclose.pif is in your windows directory.  

CTRL-ENTER 

The file under the cursor in the source directory is appended to the 
command line.  

CTRL-SHIFT-ENTER 

The file under the cursor including its path is appended to the 
command line.  

  

CTRL-

CURSORDOWN or 

A list with the latest command lines (history-list) is 

opened. Hold down 

ALT+F8 the CTRL key and use the up and down cursor keys to 

select an entry. By 

pressing the left or right key, you can edit the 

command line. This 

automatically closes the list. 

TAB or Cursor Keys Puts the cursor back to the source directory. Cursor 

left and cursor 

right move the cursor through the command line, 

even if the cursor was 

in the source directory before. If brief was selected, 
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these keys move 

the cursor through the source directory. You then 

have to hold down 

SHIFT to move it inside the command line. Cursor up 

and cursor down 

move the cursor bar inside the source window, even if 

it was inside 

the command line. 

ESC or CTRL+Y Clears the command line 

CTRL+C (32 bit) Copy selected text to clipboard 

CTRL+X (32 bit) Cut selected text to clipboard 

CTRL+V (32 bit) Paste text from clipboard to command line. 

CTRL+K Delete to end of line 

CTRL+W Delete word to the left of the cursor 

CTRL+T Delete word to the right of the cursor 

  

************************************************************* 

Keyboard Tips - 

 

Outlook 2000 Shortcut Keys 

Go to the Inbox CTRL+SHIFT+I 
Go to the Outbox CTRL+SHIFT+O 
Check for New Mail F5 or CTRL+M 
Start a New E-mail message CTRL+SHIFT+M 
Open the address book CTRL+SHIFT+B 
Start a New appointment CTRL+SHIFT+A 
Start a New contact CTRL+SHIFT+C 
Start a New meeting request CTRL+SHIFT+Q 
Start a New a task CTRL+SHIFT+K 
Make the Find a Contact box active F11 
Open the Advanced Find dialog box CTRL+SHIFT+F 
Mark an e-mail message as read CTRL+Q 
Delete an e-mail message, contact, calendar item, or task CTRL+D 

 

Front Page 2000 Shortcut Keys 
Front Page has quite a few shortcut keys. My favorites are: 
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Center a paragraph CTRL+E 
Left align a paragraph CTRL+L 
Right align a paragraph CTRL+R 
Display HTML tags CTRL+ / 
Apply the Heading 1 style (ect.) CTRL+ALT+1 
Apply the Normal style CTRL+SHIFT+ N 
Not listed in their help is: 
Cycle through Normal / HTML / Preview Ctrl-PgUp/ Down 
If you are at the last row in a table, the TAB key will add a new row below 
the current one. 

 

Fast Access to the Desktop 
To get an Explorer view of the Desktop 

1. Press Ctrl-Esc or click the Start button 

2. Press R to go to Run. Note: If you are using a Win keyboard, you can get to this 
point by pressing Win+R 

3. Type in a period 

 

Opening Up the Task Manager in NT 4 
In Windows NT 4, to quickly bring up the task manager, press Ctrl-Shift-Esc 

 

MS-Natural Keyboard Shortcuts 

Open the start menu - 

Submitted 
by Daniel F. Win 

Display the pop-up menu for 

the 

Start Explorer Win+E 

Find Files or Folders Win+F 

Find computer Ctrl+Win+F 

Minimizes all windows Win+M 

selected object - Submitted by Daniel F. 

Win+F1 

Undo Minimize All Shift+Win+M 

Display Run Dialog box Win-R  

Cycles through taskbar buttons Win+Tab 
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Displays System Properties Win+Break 

  

Getting to My Computer from 

the 
Control Panel 

If you're in Control Panel, hitting the Backspace key will switch you into the 

My Computer folder. 

  

Undo 
Press CTRL + Z to undo things like renaming a file in Explorer 

 

Minimizing All Windows 
To minimize all windows: 

1. Press Ctrl-ESC to bring up the Task Bar 

2. Press Alt-M This makes it a lot easier to minimize windows when all your open 
applications are full screen. 

 

Shortcut to System Properties 
To access the System Properties screen quickly, simply hold down the ALT key while double 
clicking on the My Computer icon. While holding the windows key, press the Pause / Break 
key. 

This will open up the System Properties box. From here you can easily get to the Device 
Manager 

 

Duplicating the Right Mouse Click 
Pressing the Shift-F10 key will be the same as clicking the right-mouse button. 

 

Accessing Programs from the Start Button 
To access your programs more quickly from your start button, with out aid of a mouse, hit 
ctrl+esc to open your start menu. Then, type the letter for the directory you are looking for. 

For example, to access the ever popular game of solitaire, CTRL+ESC, then "P" for 
programs, "A" for accessories, "G" for games, then "S" for Solitaire. If there is more than 
one entry for the letter, keep hitting the letter until you reach your desired location. Then, 
hit enter. 
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Quickly Starting Explorer 
You can quickly start an explorer session by holding down the Windows key on a Microsoft 
Keyboard and pressing the E.key 

 

Remapping the Keyboard 
You can download Keyboard Remap (20 K) from Microsoft to reassign you keystrokes. With 
this you can also assign a key to function like the Windows key on the Microsoft keyboards. 

 

Internet Explorer Shortcuts 
Here are a few IE keyboard shortcuts: 
Go `Back' to the previous page Alt+Left Arrow 

Go ‘Forward’ to the next page Alt+Right Arrow 
Add to Favorites on the current web page Ctrl+D 
Open the History folder Ctrl+H 
Open the Organize Favorites window Ctrl+B 
Lets you open a new web page Ctrl+L 
Open a new browser window Ctrl+N 
Reload the current page Ctrl+R 
Close the active Internet Explorer window Ctrl+W 

 

Bringing up the Properties Window 
While holding the ALT key double click on an icon to bring up the properties. 

 

Resizing and Moving a Window 
To Resize or Move a window: 

1. Press Alt-Space 

2. Press the S key - To Resize 

3. Press the M key - To Move You can now use the arrow keys to resize or move the 
window 

 

Key stroking is faster than mouse moving 

1. In desktop you can press "m", "My Briefcase is highlighted, press "enter" will open 
this applet. 
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2. If you do not press "enter", 

3. The next "m" key stroke will highlight "My Computer". 

4. "Ctrl"-"Esc", press "P" for Programs, "enter","M""enter", you get to the first program 
or folder that starts with "M" 

5. Other applets will also be opened the same way. 

 

Explorer Shortcut Keys 

• F4 - Displays the Combo Box 
• F5 - Refresh the display 
• Ctrl+Z - Undo last action 
• Backspace - Go up one directory Quickly Search for Files To quickly open up the Find 

all Files window 

1. Press Ctrl+ESC ESC 

2. Press F3 

 

To copy a file with a Mouse/Keyboard combo 
Drag the file while holding down the CTRL key - A + will appear on the icon To move a file 
with a Mouse/Keyboard combo 
Drag file while holding down SHIFT key - Nothing appears on the icon If moving a icon with 
the mouse and an arrow appears, it will create a shortcut. You can press shift or ctrl at 
anytime during the drag 
and it will change this little part of the icon. 

 
 
************************************************************* 

  

Keyboard Tips for Internet Explore - 

To open new Internet Expiorer Window, press CTRL+N.  

To rename an item on the Favorites list or on the Links bar, right-click 
the item, and then click Rename.  

You can drag your toolbar, Links bar, and Address bar anywhere you 
want them. You can even combine them to save space.  
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For more information about Internet Explorer features, click the Help 
menu and then click Contents and Index.  

To see the names of the buttons on the toolbar, click the View menu, 
point to Toolbars, click Customize, and then click Show Text.  

To stop downloading a page, press ESC.  

To change your home page to the page you have open, click the Tools 
menu, click Internet Options, and then click Use Current.  

To gain space on your hard disk by deleting temporary files, click the 
Tools menu, click Internet Options, and then click Delete Files.  

You can add folders to your Favorites list by clicking the Favorites 
menu and then clicking Organize Favorites.  

You can remove a shortcut from your Favorites or Links list or menu 
by right-clicking it and then clicking Delete.  

To turn off the underlines in Web page links, click the Tools menu, 
click Internet Options, and then click the Advanced tab.  

To change a favorite site's offline properties, right-click the item on 
your Favorites list, and then click Properties.  

To screen which Web sites can appear on your computer, click the 
Tools menu, click Internet Options, click the Content tab, and then 
click Enable.  

To go to the next page, press ALT+RIGHT ARROW.  

To go to the previous page, press ALT+LEFT ARROW or BACKSPACE.  

You can see a list of Web sites you have visited recently by clicking the 
History button on the toolbar.  

You can move your cursor into the Address bar by pressing ALT+D.  

You can tell if the Web site you're on is secure; a lock icon appears on 
the status bar. For more information, double-click the icon.  

You can add and remove buttons on the toolbar by right-clicking the 
toolbar and then clicking Customize.  
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You can save a Web page for offline reading by clicking the File menu 
and then clicking Save As.  

Instead of clicking the Back button, you can press the BACKSPACE key 
to move back a page.  

You can switch between a regular-sized Internet Explorer window and 
full-screen mode by pressing F11.  

To save a page or picture without opening it, right-click the link for the 
item you want, and then click Save Target As.  

You can get e-mail when a Web site changes. First make the site 
available for reading offline, then change its Download tab properties.  

To make Web pages load faster, click the Tools menu, click Internet 
Options, click the Advanced tab, then turn off sounds and pictures.  

When you add a Web page to your Favorites list, you can also make it 
available to read when you're not connected to the Internet.  

To move to the beginning of a document, press the HOME key.  

To move to the end of a document, press END.  

To see a list of all Internet addresses you have typed during this 
session, click the small down arrow at the right end of the Address 
bar.  

You can set a different level of security for each Web site. On the Tools 
menu, click Internet Options, and then click the Security tab.  

To search for a word or phrase on a Web page, press CTRL+F to open 
the Find dialog box.  

You can close the current window by pressing CTRL+W.  

To display a list of the Internet addresses you have typed in the 
Address bar, press F4.  

In the Address bar, you can quickly move the cursor back between 
parts of the address by pressing CTRL+LEFT ARROW.  

In the Address bar, you can quickly move the cursor forward between 
parts of the address by pressing CTRL+RIGHT ARROW.  
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If you use Netscape, you can learn about differences in Internet 
Explorer by clicking the Help menu and then clicking For Netscape 
Users.  

To go to a new location, press CTRL+O.  

You can install more Internet Explorer components by clicking the 
Tools menu and then clicking Windows Update.  

If you want to learn more about using the World Wide Web, click the 
Help menu and then click Tour.  

You can quickly put a shortcut to any Web page on your desktop by 
right-clicking in the page and then clicking Create Shortcut.  

To see how any Web page was coded, right-click in the page, and then 
click View Source.  

 


